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1. Preface
With the purchase of this basICColor display monitor 
cali bration and profiling software you have received a 
product that will allow you to take control of color repro-
duction in your workgroup monitors. Along with creating 
an ICC-profile, proper calibration of workgroup monitors is 
a basic and indispensable requirement for accurate color 
reproduction. Both CRT and LCD flat screen monitors can be 
profiled and calibrated with this software. Either manually, 
using the computers video card’s Video LUT, or automatically 
via hard- ware calibration (only with supported displays).
To maximize your color management results with basIC-
Color display it is important to calibrate and profile all the 
components involved in the production process, including 
scanners and printers. By implementing basICColor display 
into your workflow, you will be able to offer your clients a 
digitally color-calibrated network that can produce accurate 
off-press proofs in order to achieve the best possible printed 
and published results.
With basICColor display you have purchased an extremely 
powerful, yet user-friendly software that can resolve your 
company’s color management challenges.
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2. Installation and Licensing
2.1. Minimal Systemrequirements

Apple Computer
• Apple® with Intel Processors
• Mac OS X (10.5.6 or higher) 
• min. of 1 GB available system memory (RAM)

Windows®
• Intel® Pentium 4-Prozessor
• Windows® XP SP2, Windows® 7, Windows® 8 (32- and 64-Bit)
• min. of 1 GB available system memory (RAM)

All Systems
• Min. 100 MB free hard disk space
• DVD-drive
• Color monitor with a resolution of least 1024 x 1024 pixels 

and color depth of 24-Bit  (16,7 million colors)
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Knowledge requirements:
These instructions assume familiarity with the basic opera-
tion of the Mac OS X and/or Windows operating systems.

Documentation:
This document describes the application of basICColor 
display for both Mac OS X and Windows. Any differences in 
operation or special instructions that apply to either system 
will be indicated.

Before beginning the installation process, please make 
sure that your measurement device is not connected to the 
computer. Connect it after the software has been success-
fully installed.
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2.2. Installation
1)  Turn on the computer on which you wish to install and 

use the software.

2)  Insert the basICColor CD-ROM into your drive.
 Alternatively you can download the installer from 

www.basICColor.de.

• Mac: The basICColor CD-ROM folder will appear on 
your screen. Click on it to access the basICColor display 
Installer or open the downloaded installer. We recom-
mend a look at our download area as this ensures you 
have the latest version.

• Windows: If the basICColor display CD-ROM does not 
appear automatically go to “My Computer” and select 
the CD-ROM drive.

3)  Begin installation by double-clicking the basICColor 
display Installer. Follow the instructions on the screen.

4)  Once basICColor display has been successfully installed, 
you can begin to profile your printer. 

basICColor GmbH offers a full trial version
of basICColor display.
The software is fully functional and has no 
restrictions.
The 14-day Tryout License license is avail-
able from the basICColor license server 
(http://mylicense.biz/basiccolor).

Note: 14-day Tryout License

http://mylicense.biz/basiccolor
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2.3. Product registration and licensing
Licensing and unlocking basICColor display software is 
linked to an individual computer. You will receive an individ-
ual license that allows you to “unlock” and use the software 
on the computer on which it was installed.
The first time you start basICColor display, the “Licensing” 
window will pop up.

You can now choose to trial a full version of basICColor 
display for 14 days or request your permanent license if you 
have purchased a license for basICColor display. Therefore 
please click the <Licensing...> button.

If you have never registered on the basICColor website you 
will need to complete the registration process in order to 
obtain your personal basICColor account. With a “click” on 
<Register> you can create your personal basICColor account. 
Within seconds you will receive an email to your nominated 
email address. (Please – also check your spam folder) You 
need to confirm this email via the provided link to activate 
your account. 

Important: Without confirming this link your basICColor 
account won’t be activated! 

http://mylicense.biz/basiccolor
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If you are already registered on the basICColor website you 
can directly unlock your software from the licensing window. 
Enter your email address and your password and then either 
unlock a 14 day full trial version or your purchased perma-
nent license.

If your computer is not connected to the internet please 
log yourself onto the basICColor licensing website (http://
mylicense.biz/basiccolor) on a computer that is connected to 
the internet. Once you are logged in you can request a 14 
day full trial version OR – in case you have a TAN – you can 
request your permanent license. Once downloaded please 
transfer the license file on the computer where basICColor 
display is intalled. With a “click” on <Offline licensing...> and 
<Install License File...> in the next window you will activate 
basICColor display.

If you do not have an Internet connection at all, use the 
<Faxform...> button to open a PDF document. Fill it in and 
fax it to the number provided. The license file will be sent to 
the nominated email address. 
If required a storage device can be obtained at additional 
cost. Please contact basICColor GmbH for further informa-
tion.

http://mylicense.biz/basiccolor
http://mylicense.biz/basiccolor
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When you request a license you need to consider the follow-
ing:

 • TAN... TransActionNumber. You will find the TAN on 
a sticker on the basICColor DVD cover. Enter the TAN 
into the input field. Your license file (.lic file) will be 
downloaded and installed immediately.

  If there is no TAN on your basICColor DVD cover your 
license request needs to be processed by basICColor 
before you can access your license file (.lic file). Please 
log into your basICColor account and go to “2. Without 
TAN”. Choose “basICColor display” as product. Fill in 
the other input fields (purchased from, Machine-ID) 
and choose the the purpose for the license request: 
Initial License, Additional License, Upgrade, Site License, 
Hardware Replacement.

  Once all input fields are filled “click” on the <Submit> 
button. You will be informed that your license request 
will be processed and that you will be notified when 
you can access your license file.

On the inside of the DVD-ROM box 
you will find the TAN-Number.

http://mylicense.biz/basiccolor
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 • Machine ID... the number in this input field must match 
the number in the licensing window of the applica-
tion because the license file (.lic file) was built for this 
computer specifically.

 • Produkt... basICColor display must be selected in the pull 
down menu.

Important: the license file (.lic file) is stored in your basICColor 
account. You can access it at any time. Please ensure to 
remember your login information.

Once you have received your license file (basICColor_
display5_123456.lic) you can install it with <Offline licens-
ing...> and <Install License File...>. You will find the license file 
in the download folder of your web-browser. Now the applica-
tion is ready to use!

Now that you’ve got your personal license file (basICColor_
display5_123456.lic) you won’t need a new license file for 
software updates or a new installation of basICColor display 
as long as it’s done on the same computer. If you want to 
install basICColor display on another computer you need to 
request a new license file (basICColor_display5_123456.lic) for 
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that computer. You can purchase additional licenses from your 
basICColor dealer or basICColor GmbH directly at any time.

Hardware Replacement:
If you have bought a new computer and wish to transfer 
basICColor display please follow these steps:
1.) Install your software on your new computer
2.) Start the application and click the <Licensing...> button 

in the Licensing window. Then click the link: “Hardware 
Replacement - Request permanent license…“

3.) Please log now into your basICColor account and go to 
“Licensing” and the to the section “2. Without TAN”. 

You can check the status of your license in the licensing 
window of basICColor display. Via the menu item “Help ¬ 
License ...” you can open the licensing window and you will see 
in the upper left corner the current “Status” of your license . In 
our example, the software is permanently licensed.

http://www.basiccolor.de/dealers/
http://www.basiccolor.de/buy/
http://mylicense.biz/basiccolor
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3. Quickstart
3.1 The main window
When basICColor display starts up a main windows will pop 
up on all monitor connected to the computer. Every single 
display can be calibrated individually through this main 
window. 
All important information about the monitor and the 
calibration settings are located in this main window.
This makes basICColor display very comfortable to use 

Workflow-Icons
In the upper area of the main window is a 
row of icons located. This icons represent 
different presets to  calibrate and profile 

the individual displays.

Profile information
The currently loaded profile of the display 

and some additional informations are listed 
at the bottom of the main window 

Calibration presets
In the middle section of the window the 

different settings are listed which are used 
by the selected Workflow-Icon to create the 

calibration and profile of the display.
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3.2 Selection of the calibration preset
In the top area of the main menu is a row of Icons which 
represent different kind of workflow to those the display the 
display should be calibrated. With a click on an icon it will be 
surrounded by a line and basICColor display is prepared to 
calibrate the display for this kind of workflow.

Which detailed calibration settings (detailed information 
about the setting can be found in chapter 4 - Advanced 
settings) are represented by the workflow-icon are displayed in 
the middle section of the main window of basICColor display.

At the bottom area of the main window of basICColor display 
the current active display profile is shown. Additional infor-
mation about a color space emulation and when the display 
was validated for the last time can be found there too.
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3.3 Preparation of the monitor calibration
Before you start the calibration and profile creation for your 
display you should take a look at your display and process 
the following checks.

3.3.1 Cleanliness of the screen
Please check if the screen is clean, free of dust, fingerprints 
etc. basICColor recommends to clean the monitor each time 
before profiling.

3.3.2 Reflections / Stray Light
Turn the monitor off and check if you can see any reflec-
tions of light sources on the screen. If so, you need to change 
the monitor position and/or to shield the monitor with an 
ambient light hood.

3.3.3 Ambient Light
The ambient light in your working environment should 
comply with the relevant standards. For measuring the 
ambient light, please refer to chapter 4.10.2 Ambient light.

3.3.4 Monitor Warm Up
The colors of a monitor are becoming stable after a certain 
time. For this reason please turn on the monitor at least 30 
to 60 minutes before measuring. This allows the monitor to 
stabilize the color output.
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3.3.5 Driver for the graphic card
Please check if your graphics card uses the latest driver. 
basICColor display requires a driver which allows to write 
a video-LUT into the graphics card. Otherwise an error 
message will pop up in basICColor display during the profil-
ing process.

3.3.6 Screen Saver / Power Saving Mode
During the warm up, calibration and profiling of your 
monitors, please deactivate all screen savers and the power 
management of your operating system. 
Otherwise incorrect measurements can occur during the 
calibration and profiling process.

3.3.7 Position of the measurement device
Please check if the measurement device is positioned flat on 
the screen surface. Otherwise ambient light can enter the 
sensor, resulting in false measurements.
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3.4 Starting the profile creation
After the selection of a calibration preset the calibration and 
profiling process can be started by a click on the <Start>-
button. The <Start>-button is located under the row of 
workflow-icons.
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3.5 Selecting a measurement instrument
The next step is to select a measurement instrument in the 
pop-up window which shows up after the profile creation 
process was started.
At the first start of basICColor display there is no measure-
ment instrument selected. Besides selecting the instrument 
there are some additional options which have to be selected 
for the operating mode of the instrument.
Different measurement devices have different option which 
can be selected. For detailed information about the differ-
ent instrument setting take a look chapter 4.1 select instru-
ment.
At first the operation <Mode> of the measurement 
instrument has to be selected. Then the instrument can 
be connected to basICColor display with a clock on the 
<Connect>-button.  Follow the instructions to calibrate the 
instrument (if necessary). At last the <Monitor type> has to 
be selected (if available).
When all selections are done the window can be closed with 
a click on <Ok>.
At every next start basICColor shows the last selected/
connected measurement instrument as preselection.

basICColor recommends to connect 
the measurement instrument to 
the computer before starting basIC-
Color display.
Some instruments can only be 
identified by basICColor display 
when they are already connected to 
the computer.
For some instrument this is 
required because otherwise the 
system driver for the instrument 
will not be loaded by the operating 
system and basICColor display will 
output an error message.

Tip: Measurement instrument
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3.6 The profile creation process
After the connection of the measurement instrument with 
basICColor display a measurement window pops up.
The window should be located to the middle of the display 
and the measurement instrument has to be positioned to 
the middle of the measurement window.
If a beamer or a distance calibration of the display should be 
processed it’s possible to enlarge the measurement window 
to full screen checking the <fullscreen>-checkbox.
The calibration and profiling process can be started by a click 
on the <Measure>-button.

The following measurement sequence can be separated into 
four single parts.

3.6.1 Measuring Color Characteristic...
The first step of the calibration is to gather the actual color 
properties of the monitor. This is required to determine the 
parameters for calibration and profiling.

3.6.2 Setting the White Point...
This step sets the color temperature in the monitor hard- 
ware or via video-LUTs in the graphics card.
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3.6.3 Iterating gray balance...
basICColor display fine tunes the tonal response curve to 
the selected tonal response curve (L*, Gamma or sRGB) and 
optimizes the gray balance in an iterative process.

3.6.4 Measuring for profiling...
After calibrating the monitor basICColor display measures the 
color characteristic of the monitor again to create the ICC-profile

3.6.5 Results
After all the measurements have been processed basIC-
Color display will show you the results of the calibration 
and profiling process. The measurement window will close 
automatically, the ICC-profile will be saved to the defined 
folder and the new ICC-profile will be activated. So you don’t 
have to select and activate the profile manually.
In the main window you can see a summary of the results 
of calibration and profiling and the location, where the ICC- 
profile has been saved.

At this point the calibration and profiling of your display is 
finished and you can close basICColor display or continue 
with validating the calibration.
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3.7 Validation
After the calibration and profiling process basICColor display 
is processing a detailed check. 
This check is a simple integrity test of the calibration and 
the created profile.
This test was not designed to check if a display is able to be 
a softproofing display. It doesn’t checks if a specific gamut 
was achieved by the calibration.
The basic function of this validation is to check the integrity 
of the profile. It just checks if the display achieves the same 
values as to the time the display calibration was processed.
This validation should be used as indicator if the calibration 
and the profile is still valid or a if a new calibration/profile 
has to be created.

This validation should be used periodically to check if the 
display of the monitor has changed over the time.

The validation of the current calibration and the current 
profile of the display can be started by a click on <Validate>.
Then the already known measurement window will pop up 
again.
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Every calibration should be checked once a while (e.g. once 
a week) to check if the display calibration and the profile 
are achieving the parameters which where achieved at the 
original calibration time.
To validate the display place the measurement instrument 
in the middle of the measurement window and start the 
validation process with a click on <measure>.
Then a series of color patches will be measured and the 
results are compared to the measurements which where 
done at the time the profile was created.
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Besides the target values and the achieved values basIC-
Color display will show a tolerance value.

3.7.1 Target values
The target values are the original measurement values 
which where taken to create the calibration and profile.

3.7.1 Achieved values
These values are the current readings of the same colors.

3.7.3 Tolerances
Quite often it is hard for users to sort in the pure DeltaE 
results and to decide if the validation result is ok or if the 
display has the be calibrated and profiled again.
For this reason there are some practicular tolerances are 
preselected to help the user to determine the threshold 
where to decide if a new calibration has to be done or not. 
In the lower right area of the validation window represends 
a sinple icon if the validation has passed all criteria or not.
When all criteria are passed a green hook ( ) will be 
shown.
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But if one or more criteria did not passed the validation the 
basICColor display will output a red cross ( ) instead.
The validation criteria can be seen more like a recommenda-
tion than a strict order to create a new profile. Every user 
has to decide by himself if a new calibration has to be done 
or not.

3.7.4 Display CIEAB
This check box lets you switch between Lab and XYZ values, 
it is checked by default.

3.7.5 Load validation result...
For every created validation basICColor display will save the 
measurements in the background.
To load a saved validation report click on <Load validation 
result...> and select a validation from the list. The valida-
tion results are saved by the date and time they have been 
created.

3.7.6 Save report as...
Another useful option of basICColor display is to save the 
currently shown validation result as a PNG-image file.



Chapter 4

Advanced  
Settings
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4. Advanced settings
This part of the manual contains additional informations 
and explanations related to the settings and functions of 
basICColor display.

4.1 Selcet instrument
If the measurement instrument was not identified automat-
ically or if you want to change the instrument it is possible to 
select the instrument manually. By a click on the insturment 
icon in the top left in the advanced window of basICColor 

Symbole für die auswählbaren Messgeräte.

basICColor 
SQUID2

basICColor 
SQUID

basICColor 
SQUID3

basICColor 
DISCUS

DTP 94ColorMunki Eizo 
Swing

Chroma 5

EyeOne 
Display LT

EyeOne 
Display 2

EyeOne 
Display pro

EyeOne 
Display

Konica Minolta 
CA-210

EyeOne
pro

Konica Minolta  
KM-FD7/5

EyeOne 
Monitor

Datacolor 
Spyder2

Sequel 
Chroma 4 USB

Datacolor 
Spyder 3

OPTIX 
XR

Supported measurement instruments
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display or by selecting “File -> Select Measurement Device...” 
in the main menu of basICColor display the measurement 
device selection window will pop up.
Select the instrument of your choice in the selection list and 
connect the instrument with a click on <connect> and follow 
the given instructions.

4.1.1 Mode
LCD- and CRT-Displays need different adjustments of the 
instrument to be calibrated. Some instruments are offering 
a preselection of the mode the instrument should run in. 
Depending of the kind of display you would like to profile it’s 
possible to select between “LCD-monitor” or “CRT-monitor”.
Some other instruments are offering the mode “spectrum” 
which can be used to calibrate CRT- and LCD-displays.

4.1.2 Monitor Type
Some modern colorimeters like the basICColor DISCUS or the 
basICColor SQUID3 offering a quite more optimized adjust-
ment of the instrument to the used monitor. It’s possible to 
select a specific type of display or even a specific monitor 
model. Please contact the manufacturer of your monitor to 
get information about the used technology of your monitor. 

LCD-Flachbildschirm CRT-Röhrenbildschirm
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Also please consult the documentation of your measure-
ment instrument to select the right setting for your type of 
monitor.
This selection is quite important of the way how your 
measurement device is measuring the charatecristics of your 
monitor. If a preselection of the monitor type is done which 
doesn’t fit the characteristics of your monitor it’s possible to 
get a not optimized calibration.
Please click on <connect> to connect basICColor display and 
the measurement device with each other.

When the instrument was connected with basICColor 
display and the calibration was done you can leave the 
dialog by a click on the <OK>-button.
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basICColor display is supporting the following measure-
ment devices:

Colorimeter:
• basICColor DISCUS
• basICColor SQUID
• basICColor SQUID 2 
• basICColor SQUID 2 WG
• basICColor SQUID 3
• basICColor RAY (please select X-Rite DTP 94 USB)

• datacolor Spyder 2
• datacolor Spyder 3
• EIZO Swing
• Monaco OPTIX XR
• NEC MDSV Sensor (please select basICColor SQUID2/SQUID2wg)

• X-Rite DTP 94 USB
• X-Rite Eye-One display
• X-Rite Eye-One display 2
• X-Rite Eye-One display 2 WG
• X-Rite Eye-One display LT
• X-Rite i1Display Pro

Spectrophotometer:
• Konica Minolta FD-7/5
• X-Rite Eye-One Pro
• X-Rite Eye-One Monitor
• X-Rite ColorMunki
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Note: Please be informed that not all instruments are supporte 
by all operating systems!
Some older instruments are not supported by the latest 
operating systems and some newer instruments are not 
supported by older operating systems. 



36

basICColor display 5
Because it simply works!

4.2 Monitortype
A correct calibration of your monitor is the basis for a good 
profile. The better you pre-adjust the monitor hardware to the 
desired display characteristics, the better the quality of the 
resulting profile. By calibrating the monitor you will improve 
the representation of all colors because the profile conversion 
will have to correct for less and smaller differences.
basICColor display offers three different calibration methods. 
At first launch it will automatically select the highest level 
method available for your monitor/video card combination. 
When you quit the application, the calibration method you 
may have selected manually, will be stored and recalled next 
time you use basICColor display.

4.3 Calibration method
A correct calibration of your monitor is the basis for a good 
profile. The better you pre-adjust the monitor hardware to 
the desired display characteristics, the better the quality 
of the resulting profile. By calibrating the monitor you will 
improve the representation of all colors because the profile 
conversion will have to correct for less and smaller differ-
ences.
basICColor display offers three different calibration methods. 
At first launch it will automatically select the highest level 
method available for your monitor/video card combination. 
When you quit the application, the calibration method you 

Video-LUT of a 
monitor with a full 

hardware calibration

Result: All RGB-colors 
can be used for 

the output on the 
monitor

Video-LUTof an 
automatic/manually 

combined hard/
software calibrated 

monitor

Result: Allmost all 
RGB-colors can be 

used for the output 
on the monitor.

Video-LUT of a non- 
calibrateable monitor 

(e.g. a notebook)

Result: A lot of 
RGB-colors are 

getting lost for the 
monitor output.
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may have selected manually, will be stored and recalled next 
time you use basICColor display.

4.3.1 Hardware calibration
Hardware calibrateable monitors are connected to the 
computer via a digital data connection. This could be a DDC/
CI video cable or a separate USB or serial cable. basICColor 
display uses this connections to directly control the monitor 
and to calibrate it automatically, based on the results of 
your measurements.
This functionality is only available for selected, hardware 
calibrateable monitors (see „HW_Support_List.txt“ in the 
basICColor display program folder).

LCD flat screens
LCD monitors normally use a backlight with defined lighting 
characteristics. Colors are generated by filtering this light 
source with liquid crystal filters. 
Simple LCD monitors work with internal signal processing 
with 8bit accuracy (256 steps per primary color). Depending 
on the desired white point (e.g. D50) the intensity of one or 
more channels must be reduced considerably. This results in 
a loss of a considerable amount of steps in the colors that 
have been reduced and thus in a loss of display quality. 
The result is banding. Highlights and shadows can also be 
affected.

LCD-monitor
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Hardware calibrateable LCD monitors work with signal 
processing of 10 or more bits per channel (e.g. 10 bits = 1024 
steps). 
If one channel should be reduced to 50% there will be enough 
remaining data to describe the 256 steps of the color signal 
sent to the monitor. This means that there is differentiation 
between all the colors, they do not get clogged up.
This alone does not make a monitor hardware calibrate-
able. The monitor needs to be able to communicate with 
the calibration software. Besides the white point (color 
temperature) and luminance, some hardware calibrateable 
monitors allow for controlling gradation curves so that no 
correction needs to be done in 8 bits on the video card (e.g. 
the NEC SpectraView series). 

CRT monitors
Hardware calibratable CRTs need to be connected to the 
computer via a digital data connection. That way color tem- 
perature, brightness and contrast can be controlled. CRTs 
do not have any means to control the gradation curves. The 
correction of the monitor gradation needs to be done with 
video-LUTs in the video card. These are stored in 8 bit accu- 
racy in the ICC-profile.
Hardware calibratable CRTs are not supported by basICColor 
display. All the parameters a hardware calibration would set 
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automatically can be set manually, but instrumented with 
the help of „Hardware setup“ in basICColor display.

For optimal calibration and profiling results for soft proofing 
and high-end image retouching, basICColor recommends 
the use of hardware calibratable LCD monitors.

4.3.2 Combined hard- and software calibration
Some modern monitors are offering a partial calibration in 
hardware (i.g. Apple displays or some NEC MultiSync displays). 
This means some adustments of the monitor can be done in 
hardware directly and some adjustments have to be done via 
the graphic card’s video LUT (Look up table).basICColor display 
is able to address this parameters of the display directly in the 
hardware for some types of monitors (see HW_Support_List.
txt in the basICColor display application folder). 

4.3.3 Software calibration
The monitor hardware needs to be set manually by the 
user, using monitor controls or the on-screen-display (OSD). 
basICColor display assists you in setting these parameters 
with measurements from your monitor instrument.
Like in CRTs, the gradation settings are not accurate and 
need to be corrected via video-LUTs. These are stored in the 
ICC-profile and downloaded to the video card on system 
start-up.

CRT-monitor
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LCD flat panels
Some LCD monitors offer near to none of these control 
options (e.g. notebook monitors). Some of them have a 
brightness control only, which dims the backlight (not to 
be confused with CRT’s brightness control which sets the 
luminance of the black point).
Due to the necessary correction, these monitors are not 
suited for color critical work or for soft proofing.
LCD monitors with an analog connector only will yield 
inferior calibration quality altogether.
Higher quality LCD monitors (like the NEC MultiSync family 
of monitors) offer 10 or more bit data processing. Only this 
type of monitors satisfies higher quality demands.
These monitors offer settings for black and white luminance 
and white point.

CRT - monitors
In CRTs the intensity of the 3 phosphors is controlled by 
an analog signal that can be modulated nearly infinitely 
variable. Since the intensity of each channel can be controlled 
individually (gain), the color temperature can be set very 
exactly. Gradation curves in a CRT can not be influenced, 
each monitor has it’s more or less fixed gamma. That’s why 
a CRT can not be calibrated in hardware completely.
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Mac OS X
The color management framework of OS X (ColorSync) 
automatically detects the presence of calibration curves in 
an ICC-profile and downloads them into the video card at 
system start-up or when allocating a different ICC-profile 
using the monitors control panel.

Windows
Some older Windows color management frameworks (ICM) 
does not support this functionality, a separate LUT-loader 
is required. basICColor display contains such a LUT-loader 
which is installed automatically into the start-up programs 
folder when installing basICColor display
At Windows start-up the LUT-loader downloads the calibra-
tion curves into the video card. When changing the monitor 
profile, the LUT-loader must be launched manually in order 
to download the correct LUT.
The downside of a software calibration, compared to hard- 
ware calibration is the reduction of tonal values by using 8 
bit LUTs in the video card. Depending from the extent of the 
correction, banding and reduced definition in highlights and 
shadows can be then consequence. This effect is annoying 
in technical vignettes, but it’s not so visible in photos.
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4.3.4 No calibration
In the worst case the graphic card does not support video 
LUT download (some PC graphic cards). The monitor must 
then be characterized in it’s present state. Corrections for 
color temperature and tone curve are not available in this 
mode. Also, adjustment of luminance and contrast can only 
be done manually.

basICColor display supports you with measurement values 
in setting these parameters.

Should the graphic card contain a LUT when launching 
basICColor display it will be taken over and saved in the ICC- 
profile.

It is understandable that the results achieved with this 
method are far from being optimal.

4.4 Calibration preset
Under this section basICColor display offers you some 
standard calibration presets for the most common work-
flows. When selecting a calibration preset, all the necessary 
settings will be done automatically by basICColor display. 
You don’t have to select all the calibration options like “Color 
temperature”, “Tonal response curve” etc. separately.
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Using this option speeds up the calibration and profiling 
process and makes working with basICColor display much 
easier.

You can even make your own presets. Please find a detailed 
explanation in the extended part of the manual (chapter 4). 
If you like one of the presets, or if you made your own preset 
then just select the set which you like to use for calibrating 
and profiling your monitor and go on with the next step. You 
can select one of the following presets:

 Softproof - This is the recommended preset to use a 
monitor in a softproof enviroment.

 Photography Outdoor - This set contains optimized 
settings to be used for judging images in an outdoor 
set.

 Photography Indoor - If you want to use your monitor 
to judge images in an indoor set your monitor should 
be calibrated by using this preset.

 Webdesign - This preset will set up your monitor for a 
webdesign worklfow.
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 Prepress - This preset contains the correct settings 
to calibrate a display to the needs of the Prepress-
Workflow.

 Besides this preset is can be recommended to photog-
raphers who wants to retouch their images for the 
output of an photo-lab, Fine-Art-Printers, Inkjets or 
other printing devices.

 DICOM LUT - This preset can be used to optimize your 
monitor for an medical workflow.

 CIE LUT - This is another preset to set up the monitor for 
a CIE based medical workflow.

 Adobe RGB (1998) - The monitor will be set up to 
optimized for an AdobeRGB workflow by using this 
preset.

 custom... - If any setting of an existing preset will 
be changed then the name of the preset changes to 
“custom...”.
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Some of those presets are already represented by a 
workflow-icon in the main window of basICColor display.

An exception is the last workflow-icon of the main window 
of basICColor display. The default setting for it is “custom”. 
But this workflow-icon is a placeholder for a whole list of 
calibration presets. The name and the preset which are 
represented by this workflow-icon can be changed.

It is possible to select between all calibration presets except 
those which are already represented by a workflow-icon.
To change the calibration preset for this workflow-icon make 
a right-mouse-click on the icon.
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After the selecetion of a calibration preset the look of the 
workflow-icon won’t change. But the name under the 
workflow-icon will change to the name of the selected 
calibration preset.

The calibration settings which are represented by workflow-
icon can be seen in the middle of the main window of basIC-
Color display.
If the custom workflow-icon will be used to create a calibra-
tion and profile for the display these new settings will be 
used then.
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4.5 Creating custom calibration presets
A calibration presets contains settings for the parameters 
of “Presets”, “Color temperature”, Tonal response curve”, 
“Luminance/contrast ratio” and “Profile”. By combining 
these settings to a calibration preset the single options 
don’t have to be selected each time you want to use a 
defined combination of calibration parameters. This will 
makes basICColor display very comfortable and fast to use.
As mentioned in the previous section a single change on a 
parameter will rename the calibration preset form it’s origi-
nal name to the name “custom...”.
At this point basICColor display gives the user the oppor-
tunity to save these new calibration settings as a custom 
calibration set with it’s own name.
To save the calibration settings as new set, please select “File 
-> Save presets...” from the main menu of basICColor display. 
Alternatively use the shortcut ⌘S to get to the same dialog.
In the dialog for saving the new calibration preset all the 
selected calibration parameters are listed. At the bottom of 
the window is a field where the name of the new calibration 
preset can be defined.
By a click on the <OK>-button the new calibration preset wil 
be saved and the dialog will close automatically.
The new calbration set can be chosen from the list of calibra-
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tion presets like any other predefined calibration preset. It’s 
possible to activate the new created calibration preset via 
the custom workflow-icon in the main window of basIC-
Color display.
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4.6 Color Temperature
If you heat up a black body you will see that it radiates light. 
The spectral distribution of the emitted light can be corre-
lated with the temperature of the black body. Any light‘s 
color temperature is the temperature in kelvins (K) at which 
the heated black-body radiator matches the hue of the light.

The lower the color temperature, the more yellowish/red- 
dish the emitted light (e.g. incandescent lamp -> approxi-
mately 2800 K). The higher the color temperature, the more 
blueish the emitted light (e.g. not calibrated CRT monitor -> 
approx. 9300 K).
Color temperature only describes a certain color sensation, 
not a specific spectral distribution. So, it’s unknown, how the 
measured x and y values are composed spectrally. The CIE 
(Commission Internationale de l‘Eclairage) have de- fined 
spectral distributions of standard lighting situations, the 
most important of which is the D-series (D = Daylight).

basICColor display offers quite a lot of different possibilities 
to make a selection for the color temperature. 

D50 spectral distribution curve

„D50“ spectral distribution curve of a CRT monitor
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D50
For the graphic arts industry, D50 is the standard for viewing 
and comparing color. Also the color systems L*a*b* and XYZ 
as we use them in graphic arts, are based on this illuminant. 
These are the reasons why a computer monitor in an ICC- 
compliant working environment needs to be calibrated to 
D50.

D65
This is the standard illuminant for the manufacturing indus-
tries (automotive, textile etc.), office and video production. 
If you are in one of these trades, you should calibrate your 
monitor to D65.

Other Dxx
For specific purposes it may be advisable to calibrate to a 
different daylight white point. Enter the full correlated color 
temperature here (e.g. 7500)
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Monitor’s native
Each monitor has it’s own, typical white point, that is dis- 
played when all 3 channels, R, G and B (Gains) are set to max. 
With this setting he luminance and gamut of the monitor 
are at their maximum.
„Monitor’s native“ is not recommended for color critical 
work in an ICC workflow. This setting may be useful for lap- 
top monitors if their luminance is inadequate after calibrat-
ing them to D50.

Blackbody temperature
As described earlier, an illuminant can be characterized with 
its correlated color temperature. D50 for example has an 
approximate color temperature of 5000K, but the blackbody 
radiator has a different spectral distribution at 5000K.
Monitors show a different, characteristic spectral distribu-
tion, their white point can only be approximated.
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4.7 Tonal response curve
Shades of gray from black to white will be reproduced in a 
specific way, depending on the individual monitor. CRTs and 
LCDs are very different in their native characteristics. In order 
to normalize the response character monitor calibration 
corrects the tonal response curves to a defined function.

L* (recommended)
Theoretically, the ideal color system for cross media publish-
ing is L*a*b*. It equals the characteristics of human color 
perception. So, it is logical to combine the advantages of the 
L*a*b* with the representation of tone values on a monitor.

The L* method calibrates your monitor in such a way that 
gray scales appear visually equidistant. If you increase the 
R, G and B signals by the factor 2, the displayed color will 
be doubled in brightness. This way the RGB monitor space is 
optimally adapted to the human visual sensation.
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Since ICC profiles are based on L*a*b* as well, the conversion 
losses are minimized when converting color to the monitor 
gamut. If you calibrate your monitor to L*, your RGB working 
space should have an L* tonal response curve also. You can 
download such a working space (ECI-RGB v2) from www.eci.
org.

Gamma
The Gamma function is based on the native behavior of CRT 
monitors. In CRTs, an electron beam excites red green and 
blue phosphors on the tube’s surface. Depending from the 
intensity of the electron beam, the phosphors glow more or 
less bright.
Yet the intensity is not directly proportional to the voltage 
that controls the exciting electron beam. The ratio equals 
a gamma function. This gamma function can easily be 
modified into a different gamma behavior.
In the early days of monitor calibration, it seemed a good 
idea to calibrate a monitor to a gamma that is similar to the 
tonal response of printed matter, to be precise, gamma 1,8 
was the characteristic of an Apple LaserWriter. Thus gamma 
1.8 became the typical Apple monitor gamma. On a PC, 
where you normally did your bookkeeping, wrote letters and 
prepared presentations, a more contrasty characteristic was 
desirable. Thus gamma 2.2 became the typical PC gamma.
In a color managed environment these historic gammas do 
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not make sense any more. For one, because LCD monitors 
show a completely different native tonal response, on the 
other hand the monitor profile compensates for different 
tonal curves anyway. So it makes more sense to calibrate 
your monitor to a tonal response curve that affects the data 
you want to display the least: L*.

The only use of a gamma calibration is a workflow with 
data which need to be displayed with a certain gamma or 
other tonal response curve (e.g. video or web design = sRGB) 
out- side a color managed environment. In all other cases, L* 
calibration is the better choice.

RGB IEC61966-2.1
sRGB is a working space for monitor output only. You find it 
mainly in the areas of Internet, multi media video and office 
applications. The tonal response curve cannot be described 
with a gamma function (although Photoshop, for example, 
reports a gamma value of 2.2). In the shadows, it resemble 
more an L* curve, in the mid tones and highlights it follows 
the gamma 2.2 curve. In order to exactly match sRGB data, 
SpectraView Profiler is the only monitor calibration applica-
tion that offers an sRGB calibration curve for these applica-
tions.
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CIECAM02
How the effective contrast ratio will be reproduced in an 
workflow doesn’t depends on the monitor alone. Also the 
lightning conditions of the room is having a lot of influence 
on the effective contrast ratio of the monitor.
In a very bright en lighted room the effective contrast of the 
monitor will not be the same like using the same monitor 
in the same room, but without any additional light sources 
and closed curtains (e.g. dark room).

One part of CIE Color Apperance Model 02 (CIECAM02) is to 
take care about the luminance of the ambient light of the 
room. The monitors gradation curve can be optimized to the 
luminance of the rooms ambient light to optimize the effec-
tive contrast ratio (combination monitor and ambient light) 
by choosing on of the CIECAM02 setting.
The NEC recommends to use one of the following settings 
depending on luminance of the ambient light of the room:

 0 - 32 Lux: CIECAM02 - dark

 32 - 64 Lux: CIECAM02 - dimmed

 >= 64 Lux: CIECAM02 - bright

The luminance and the white point of the ambient light 
of the room can be measured with a measurement device 
which supports ambient light measurements (e.g. basICCo-
lor SQUID 2 or X-Rite Eye-One pro).
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4.8 Luminance / contrast ratio
Here you can define parameters that are important in differ-
ent ways. 
If you should use several monitors in your environment, it 
makes sense to harmonize them to the same visual appear-
ance. These settings allow you to do so in different ways.

White luminance
The addition of all 3 RGB primaries results in white light of 
the highest possible quantity of light. That makes white the 
brightest color a monitor can show. 
If you reduce the brightness of an LCD monitor or the 
contrast of a CRT, the quantity of light and thus the white 
luminance will be reduced.
All monitors have a different native white luminance. In 
order to be visually equal, they need to be calibrated to the 
same maximum luminance. The reference is always the 
monitor with the least brightness. All other monitors must 
be adjusted to the darkest one.

In order to determine the max. luminance for a given white 
point, you need to calibrate the monitor with the „maxi- 
mum“ radio button checked. In order to determine the 
luminance of a second monitor, create a white desktop on 
that monitor, click the „Measure“ button and follow the 
instructions on the screen.
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Black luminance
For the visual appearance of a monitor, not only the tonal 
response curve and the white luminance are of importance, 
but also the black luminance. basICColor display allows you 
to calibrate monitors to a defined black luminance. Here the 
highest black luminance is the reference for harmonizing 
multiple monitors.
In order to determine the min. black luminance for your 
monitor, you need to calibrate the monitor with the „Mini- 
mum“ radio button checked. 
In order to determine the black luminance of a second 
monitor, create a black desktop on that monitor, click 
the <Measure> button and follow the instructions on the 
screen.

Contrast
The ratio between brightest and darkest value of a monitor 
is called contrast ratio. The higher the contrast ratio, the 
better is the differentiation of tonal values.

If white luminance and black luminance of two monitors 
are equal, the contrast ratio is the same. So, it is irrelevant if 
you calibrate to the same white and black luminances or the 
same luminance and contrast ratios.

The contrast control (OSD) of an LCD moni-
tor works completely differently from CRTs. 
In most cases, there is no need to change 
the contrast settings. Please reset contrast 
to factory settings before attempting to 
calibrate an LCD monitor.

Tip: Contrast control in LCDs
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Specify
Here you select the two parameters you intend to use for 
the calibration, the third one will be grayed out and will be 
calculated automatically.
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4.9 Profile
ICC-profiles can use a different internal structure for some 
parameters. Two important parameters are the profile type 
and the chromatic adaptation.

4.9.1 Profile type
The function of an ICC profile is to describe the color charac-
teristics of your devices in a device independent color model 
(e.g. CIELab). 
It doesn’t make sense to describe all 16.7 million color in 
a profile, this would result in a huge file. So, only a certain 
number of color combinations will be described in a profile, 
the others will be interpolated mathematically.

Matrix based
The simplest way to describe the color properties of a device 
is a color matrix. It contains the 3 primaries red, green and 
blue and a function that describes the tonal response curves 
for the 3 channels.
The main advantage of this profile type is its small size  
(4 -8 KBytes, depending from the way, your hard drive has 
been formatted). Matrix profiles are thus best suited for 
applications where size matters, e.g. the internet.
The downside is that a not so perfect device cannot be de- 
scribed accurately.
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16-BIT LUT-based
In this profile type, the gamut of a device will be described in 
a table of a defined number of points. All other color values 
will be interpolated. This allows to describe non-linear 
behavior of a device. The size of a LOUT profile can be some- 
where between 200 KB and more than 2 MB.
With 16 bit encoding, the accuracy of a LUT profile will be 
increased dramatically (256 times more accurate), while the 
size only doubles. That’s why SpectraView Profiler offers 16 
bit LUT profiles only.

4.9.2 Chromatic Adaption
Chromatic adaptation is the ability of the human visual 
system to discount the color of the illumination and to 
preserve the appearance of an object. Chromatic adaptation 
can be observed by examining a white object under differ-
ent types of illumination, such as daylight (blueish) and 
incandescent (yellowish). The white object retains its white 
appearance under both light sources, as soon as the viewer 
is adapted to the light source (discounting the illuminant).

Within the ICC color management system, D50 is the 
reference illuminant. Should a monitor be calibrated to a 
different white point (e.g. D65), all colors displayed on this 
monitor need to be converted so that they appear like they 
were being viewed under D50 lighting.
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Such transformations are called Chromatic Adaptation 
Transforms (CATs). There has been a significant amount of 
research in determining CATs that are able to accurately 
predict color appearance across different illuminants. The 
transforms currently in use are based on minimizing percep-
tual error of experimental corresponding color data sets.

none
Is not really no CAT, it rather means: No other than the 
preferred ICC chromatic adaptation method.

von Kries (HPE) 
The von Kries CAT assumes that chromatic adaptation is 
in- deed an independent gain control of the cone responses 
of the human visual system, and that the scaling is based 
on the ratio of the cone responses of the illuminants. Visual 
result: On a monitor calibrated to a higher color temperature, 
all colors appear (compared to CAT „None“) a bit warmer 
and more saturated. The opposite is the case for monitors 
calibrated to a lower color temperature than D50.

lineare Bradford
A widely used newer chromatic adaptation transform is the 
Bradford transform. It was empirically derived by Lam from 
a set of corresponding colors as determined from 58 dyed 
wool samples with varying color constancy, evaluated under 
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illuminants A and D65. The original Bradford chromatic 
adaptation transform contains a non-linear correction in 
the blue region. In many applications, as in SpectraView 
Profiler, this non-linearity is neglected. Changes appear less 
intensive than in the „von Kries“ method.

CAT02 (von CIECAM02)
This is the latest development in CATs, it’s effect is close to 
that in the „linear Bradford“ method. basICColor display 
uses CAT02 as a default.

4.9.3 V4 profile
If you check „ICC v4 profile“ SpectraView Profiler will create 
ICC profiles according to the latest specification (including 
the correct chromatic adaptation tag).
Under windows, v4 profiles do not make sense since the 
Windows color management system ICM is not capable 
of utilizing these profiles (ACE, the CMM built into Adobe 
products can handle v4 profiles).

4.10 Review
Under this tab you will find some useful quality assurance 
and editing tools.
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4.10.1 Monitor
This tool allows you to check the quality of any profile and 
calibration, not only those created with basICColor display.
After measuring the validation patches you see the „Valida-
tion Results“ window. The measured values are compared 
with the reference values calculated from the ICC profile. 
For each patch you will find a DeltaE information along with 
Deltas for L, a and b separately.

display CIE LAB
This check box lets you switch between Lab and XYZ values, 
it is checked by default.

Tolerancing model
With the radio buttons in the upper right corner of the 
window, you can switch tolerancing models from DeltaE 
94 (de- fault) to DeltaE (Lab). The latter is still the standard 
method for determining the distance between two colors, 
while the first is more accurately adapted to the human 
visual system.

The DeltaE-2000 model is one of the latest tolerancing 
models. It’s an improvement on the DeltaE-94 tolerancing 
model. And it’s getting more and more popular in the daily 
business.
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4.10.2 Ambient light
This does not influence the results of calibration and profil-
ing, it is for your reference only. On the other hand, you 
can find essential informations that help you set up your 
working environment.

basICColor SQUID 2 / GretagMacbeth EyeOne display2
In order to measure ambient light, you have to attach the 
ambient light head.

Gretag Macbeth EyeOne pro
Not all Eye-One spectrophotometers support ambient 
light measurements, you need one that came with the 
„Ambient Light Head“.
 

For ambient light measurement, basICColor display offers 
reference data for three different situations. Check the radio 
button that represents the desired situation.

In order to measure ambient light, click <Measure>.

10.4.3 Ambient Light
In order to be able to judge colors accurately on a monitor, 
you need a controlled environment as described in ISO 3664 
and ISO 12646. 
These standards demand for a dimmed surrounding with a Positioning basICColor SQUID2 for ambient 

light measurement.

Mounting the ambient light head on a 
basICColor SQUID2
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not more than 32 lux and a color temperature close to D50.

Attach the ambient light head to the instrument and hold 
the instrument in front of your monitor with the ambient 
light head facing the room, not the monitor.

10.4.4 Check viewing booth
For a comparison of a proof and a soft proof, the viewing 
booth should have an illuminance value of 500 ± 125 lux and 
a color temperature of D50. 

Again, attach the ambient light head to the instrument and 
hold the instrument towards the back wall of your viewing 
booth. Make sure the background is a neutral gray. In doubt 
use a gray card that has no metameric failure, like the basIC-
Color gray card.

In the measure window, you’ll see the measurement values 
updated with each measurement. Thus you can adjust your 
ambient light or viewing booth until the required values 
have been reached.
Click <Done> and then <Close> when you want to stop 
measuring. The achieved values will be displayed next to the 
reference values so that you can compare the results.

Mounting the ambient light head on a 
GretagMacbeth Eye-One Pro

Positioning of the GretagMacbeth Eye-One Pro 
for ambient light measurement
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Viewing booth for hardcompy comparison only
A viewing booth that is being used for comparing print and 
proof, is supposed to show an illuminance value of 2000 lux 
± 500 lux and a color temperature close to D50.

Attach the ambient light head to the instrument and hold 
the instrument towards the back wall of your viewing booth. 
Make sure the background is a neutral gray. When in doubt, 
use a gray card that has no metameric failure, like the basIC-
Color gray card.

4.10.5 Adjust viewing booth
Using this setting will adjust the lightbooth’s brightness to 
the brightness of the monitor. Only then it will be possible 
to compare a photographic print, proof or any other artwork 
with the display on the monitor.
basICColor display communicates with the lightbooth and 
will automatically adjust its brightness to the monitors 
brightness. Please take notice that the monitors brightness 
should be set to a standardized value. The ISO 3664 requires 
a luminance of 500 +/- 125 lux.
Other settings are also possible but then they are not 
standardized and other users may not have the same 
exposure at their facilities.
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Viewing boot for hardcopy comparison only
By using this setting the light booth will be automatically 
adjusted to a luminance of 2000 lux. This is the standard-
ized luminance to compare artwork, photos and/or press 
prints to proofs.
This setting should not be used to compare (e.g. a proof) 
with the display on the monitor.

other value/other value (emission)
To be not bound only to standard settings, it is possible to 
adjust the lightbooths luminance to a custom value. The 
values can be entered in the measuring units Lux (lx) or 
candela per square meter (cd/m2).

4.10.4 Edit calibration
In principle there should be no need to edit the calibration 
performed by basICColor display. There are rare occasions 
when the monitor still shows a color cast after calibration 
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(depending from the filter set in the instrument and the 
phosphor or LCD filter set of the monitor). In these cases you 
can edit the calibration curves manually. basICColor display 
offers two edit modes:

White point
In this mode you can influence the brightness in all three 
channels or in 1 selected channel without affecting the 
shape of the calibration curve. If you click and drag the 
white point, you reduce or increase white luminance in the 
selected channel. Once you have reached 100% and continue 
dragging, contrast, but not the intensity will be increased, 
but you will lose definition in the highlights.
If you click and drag the black point, you can increase 
black luminance in the selected channel, which affects the 
contrast ratio as well.

Curves
This option allows you to change the shape of the tonal 
response curves with three additional handles.

White point edit: On the left, the white point was raised. You 
can see how many colors turn to white. On the right, lumi- 

nance and contrast have been reduced

Black point edit: On the left, the black point was reduced. You 
can see how many colors turn to black. On the right, lumi- 

nance was raised which results in a reduced contrast
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Edit curve(s)
Here you select, which curve(s) you want to edit.

 All - All Curves are affected in the same manner.

 Red - Only the tonal response curve of the red 
channel will be affected. Blue and green channels 
remain unaffected.

 Green - Only the tonal response curve of the green 
channel will be affected. Red and blue channels 
remain unaffected.

 Blue - Only the tonal response curve of the blue 
channel will be affected. Red and green channels 
remain unaffected.

 
 Undo - Undo the last change.
 
 Reset - Revert curves to the LUTs stored in the 

profile.

 Save - Write curves into the active profile.
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4.10.5 Color Space Emulation
Some high-end monitor have an internal 3d Look-Up-Table 
(3D LUT) which allows it to manipulate the color charak-
eristics of the display. This makes it possible to emulate 
the shape and size of a different color space instead of 
using the native color gamut of the display. This means a 
wide-gamut display with a color gamut of about 100% of 
AdobeRGB (1998) can reduces in it’s gamut to e.g. the shape 
and size of an sRGB-display.
When a monitor emulates a color gamut it’s not possible 
any more to show higher saturated colors than the colors of 
the emulated color gamut. Even when the monitor is able to 
show those colors in it’s native color gamut!
Excluded from the emulation of the color gamut is the white 
point and the tonal response curve of the monitor (and of 
course the black- and white-luminances).

Tip: If a Wide-Gamut display should emulate a color gamut  
as good as possible then the color temperature and the tonal 
response curve should be calibrated to the native settings of 
the color gamut which should be emulated.

To activate a Color Space Emulation on supported displays 
just select an ICC-profile from the list. All ICC-profiles which 
are installed on your system are listed
To activate the Color Space Emulation click on the <Save>-
button at the bottom of the window.
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5. Preferences
To open the preferences of basICColor display press �,.
In the preferences some settings for the work with basIC-
Color display can be selected.

Please mention that some of the settings become active 
after a restart of basICColor display.

5.1 General
In this tab the general settings for basICColor display can be 
set up.

5.1.1 Language
Select the language basICColor display should use from this 
menu.

5.1.2 Measurements
Additionally you can define if yo want a click tone with every 
measurement.

5.1.3 Calibration options
When this check box is active basICColor display uses less 
color patches to create a calibration and the profile.
It will speed up the application, but it is less accurate than 
using more color patches.
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5.1.4 Path to the analysis software (catch)
basICColor display can send the measured values to an 
external quality control software (basICColor catch) for a 
more detailed review.
Please enter the path to the basICColor catch folder into this 
field.
For more information about the detailed review in basIC-
Color catch, please consult the documentation of basICColor 
catch.

5.2 Profile creation
In this tab some presets for the profile creation can be set 
up.

5.2.1 Save profiles to
This dialog allows you to specify the folder for storing the 
ICC-profiles you create. (For the System profiles folder you 
will need administrator rights, for the user profiles folder, 
standard user permissions are sufficient).
If you want to save the created profile into an alternative 
folder you can select this custom folder here too.

5.2.2 Profile name default
By default basICColor display names the created profiles 
some preselected phrases. By activating a checkbox this 
phrase will be added to the profile name.
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5.3 Security
In this section you can define a station ID, if more than one 
softproof-stations have to be administrated. If you leave the 
field blank, the machine ID will be inserted.
Additionally you can specify name and path to the proto-
col files, i.e. to create copies of protocol files on a network 
storage.
You can also activate password security which allows the 
start of basICColor display only after entering the correct 
password.
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5.4 Display settings
Some monitors offer additional hardware settings which 
are not part of a pure calibration (e.g. NEC SpectraView 
Displays). basICColor display can control and change this 
additional settings.

So it’s possible to lock the OSD (On-Screen-Display) of NEC 
displays by activating the check box in this tab.

Additionally some displays like the NEC SpectraView series 
allow it to change the settings for the Digital Uniformity 
Control (ColorComp).
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5.5 Online-Services
This feature is supported in a future version of basICColor 
display.
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5.6 Settings in the main menu
basICColor display additional function can be activated 
directly through the main menu of basICCor Display.

5.6.1 Select system profile...
At startup time your computer system loads the active 
system profile. Under Mac OS X the video-LUT that stores 
the monitor calibration information will be downloaded 
into the video card. A Windows-PC needs a separate video-
LUT loader for this task. This application is being installed 
to the Startup Programs folder when you install basICColor 
display.
If you use a hardware calibrateable monitor, neither of the 
operating systems provides a mechanism to download LUTs 
into the monitor. Normally this information is stored in the 
monitor at calibration time and stays there permanently.
If you change profiles (e.g. for different workflows - photo 
and video), you need to reload the appropriate video-LUTs. 
basICColor display lets you perform these tasks with one 
click. Go to the „File“ menu „Select system profile...“ and 
navigate to the desired ICC-profile.
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5.6.2 Chromaticity and gamut / Spectral distribution
In the menu „Window -> Chromaticity and gamut“ or with 
the shortcut ⌘2 you open an additional window that shows 
the actual measurement in an x-y diagram.

On the left you see the measured X,- Y- and Z- values as well 
as L*, a* and b*. On the right you see the corresponding RGB- 
values.

Once measured, the primaries Red, Green and Blue define 
a color triangle, the gamut of your monitor, in the x-y 
diagram.

In the menu „Window -> Spectral distribution“ or with the 
shortcut ⌘1 you open an additional window that shows the 
spectrum of the actual measurement. This option is only 
available if the measurement instrument used is a spectro-
photometer. 
Click on the <Save> button to store the spectrum in an ISO- 
12642 compliant text file.

XY-graph of a measurement value in the
Chromaticity and Gamut window

Spectral distribution for the same measurement
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5.6.3 Validation results
The last validation result can be opened by holding  ⌘i or 
by selecting “Window -> Validation results...” from the main 
menu.
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6. Produkt Information basICColor display

Copyright Information

Software - Copyright © 2001-2013 basICColor GmbH.
All rights reserved.

Manual - Copyright © 2011-2013 basICColor GmbH.

The information in this manual is furnished for informational use only and is 
subject to change without notice and shall not be construed as a commitment by 
basICColor GmbH. basICColor GmbH assumes no responsibility or liability for inac-
curacies or errors that may appear in this document. No part of this user guide 
may be reproduced, transmitted, transcribed or translated into any language 
without the express written permission of basICColor GmbH.

Trademark Information
basICColor and the Fingerprint are a registered trademark of basICColor GmbH. 
All other trademarks or registered trademarks are the property of their respective 
holders (Apple, Adobe, X-Rite, Konica Minolta Sensing, ColorPartner, Barbieri) Any 
mention of these trademarks is for demonatrational use only and is not meant to 
infringe any rights of a third party.

Written by: Tim Seher

Version 1.1,  June 2013
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